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RÉSUMÉ 
 

 

 

 

 

 

Le sujet du stage s’inscrit dans le cadre d’une étude sur la technologie du circuit imprimé qui 

est extrêmement connue mais également en pleine mutation pour répondre aux nouveaux 

besoins de performance des circuits intégrés. Parallèlement, les innovations récentes des 

logiciels CAO portent essentiellement sur des technologies de conception ou de routage à un 

niveau d’abstraction élevé, afin de faire face à la complexité croissante des cartes. 

 

Le travail réalisé s’est donc décomposé en deux phases successives: une phase de recherche 

documentaire et une phase de réalisation d’une application. 

 

Nous avons commencé, dans un premier temps, par faire une recherche bibliographique qui 

nous a permis de cerner les principaux points sur la technologie des circuits imprimés, puis, 

nous avons effectué une étude comparative des logiciels de conception des PCB, ainsi que, 

l’établissement des règles de conception. Ensuite, dans un second temps, nous avons fait le 

choix du logiciel professionnel Altium Designer que nous avons utilisé pour réaliser notre 

application. Cette application consiste à la réalisation d’un mini-TNC (Terminal Node 

Controller).     
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INTRODUCTION GÉNÉRALE  
De nos jours, l’électronique est présente dans la moindre de nos activités quotidiennes, les 

voitures, les cafetières, les téléphones portables, les appareils photo et bien sûr 
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particulièrement dans les ordinateurs.  Le circuit imprimé est utilisé dans presque tous les 

appareils électroniques, de la calculatrice aux appareils électroménagers, en passant par les 

micro-ordinateurs. Ce support, qui se présente sous la forme d’une plaque en matière isolante, 

assure la liaison électrique entre différents composants électroniques soudés sur des pistes 

conductrices en cuivre. 

L'invention du circuit imprimé  est attribuée au Français Robert Kapp (1894-1965), un 

précurseur dans le domaine de l'électronique. 

Avant l’invention du circuit imprimé, les appareils électroniques étaient essentiellement 

constitués de lampes reliées entre elles par des fils (figure1).  

Ce système était très volumineux et nécessitait un travail manuel important. 

Les composants électroniques ont commencé à être miniaturisés dans les années 1940, 

notamment avec l’invention du transistor en 1948. 

 

Figure 1 - Une carte électronique avec des fils 

La nécessité de réduire les volumes et les poids des équipements électroniques a conduit les 

fabricants de circuits PCB finis ainsi que leurs sous-traitants à s’adapter à de nouvelles 

technologies. 

Dès lors, les liaisons par fils ont été progressivement remplacées par des circuits imprimés 

(figure 2). 
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Figure 2 - Un circuit imprimé avec des pistes conductrices en cuivre 

 

Une carte électronique est un ensemble de composants tel que des résistances, condensateurs 

ou circuits intégrés réunis sur une plaque de manière à former un circuit destiné à un usage 

précis. Cela nous amène donc à nous demander : Quels sont les différentes étapes, de la 

conception à la fabrication, dans la réalisation d’une carte électronique? 

Le document est organisé de la façon suivante,  

- une partie de concepts théoriques des PCB contenant un chapitre des logiciels de 

conception des circuits imprimés (CAO), un chapitre définissant les règles de 

conception d’un circuit imprimé et un chapitre présentant les étapes de fabrication 

d’une carte électronique.  

- et l’autre partie se décompose en deux chapitres: le premier présente le logiciel 

professionnel de conception des PCB Altium Designer 10, alors que le deuxième 

chapitre met en œuvre le flot de conception d’un Mini-TNC.    
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CHAPITRE 1 : GESTION DU PROJET 
1.1 Objectifs et contexte 

L’objectif de ce projet est de viser à acquérir des idées importantes sur la conception des 

circuits imprimés en utilisant le logiciel Altium Designer, de maîtriser ce logiciel de 

conception des schémas ou des circuits imprimés, et  d’avoir des solides connaissances sur le 

processus de fabrication des circuits imprimés ainsi que la familiarisation avec la technologie 

des PCB (printed circuits board ).  

1.2 Spécifications de besoin du projet 

1.2.1 Spécifications fonctionnelles du projet  

Les exigences fonctionnelles  du projet sont présentées au niveau du tableau suivant,  

Exigence 

fonctionnelle 

Description 

EF_1 La saisie de la schématique et son transfert en PCB. 

EF_2 Le placement des composants et le routage des pistes.  

EF_3 La génération des fichiers Gerbers. 

Tableau 1 - Spécifications fonctionnelles du projet. 

1.2.2 Spécifications techniques du projet   

Les exigences techniques  du projet sont présentées au niveau du tableau suivant, 

Tableau 2 - Exigences techniques du projet. 

Exigence 
technique 

Description 

ET_1 
Les dimensions de la carte électronique sont : Longueur = 124.40 mm ; 

largeur = 99 mm. 

ET_2 L’étude du logiciel Altium Designer 10. 
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1.3 OBS : structure organisationnelle  

 

1.4 WBS : structure de découpage du projet  

0000 Intitulé Contenu succinct et sorties 

associées  

1001 

 

 

Partie 2: Etude bibliographique 

Les logiciels de conception des circuits 

imprimés. 

Les règles de conception des circuits 

imprimés. 

Fabrication des circuits imprimés. 

 

"Rapport d'étude 

bibliographique"  

2002 Partie 3 : Contribution  

Etude du logiciel Altium Designer. 

Réalisation d’un mini-TNC. 

 

"Rapport de fin d’étude". 

"Schémas". 

"PCB". 

"Fichiers Gerber".  

3003 Conclusion et perspectives "Rapport de fin d’études". 

Tableau 3 – Gestion du projet. 
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1.5 Calendrier 

Les tâches réalisées La date de réalisation 

Etude des logiciels de CAO 03/05/2012 

Flot de conception des circuits imprimés 06/05/2012 

Règles pour la conception des PCBs 09/05/2012 

Guide de démarrage Altium Designer 11/05/2012 

L’entame de réalisation de l’application 22/05/2012 

Début de réalisation de la schématique  22/05/2012 

Fin de la réalisation de la schématique  23/05/2012 

Le transfert de la schématique vers le PCB 24/05/2012 

Génération des fichiers Gerber 29/05/2012 

Finalisation du travail  31/05/2012 

Tableau 4 - Le calendrier du déroulement du projet de fin d’étude.  
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CHAPITRE 2 : LES LOGICIELS DE CONCEPTION DES 

CIRCUITS  IMPRIMÉS (CAO) 

Les   informations   présentées   dans   ce   chapitre   sont   extraites   des documents 1 et 2.  

Parmi les diverses tâches nécessaires avant la production d’une carte à circuit est la 

conception. La conception est généralement accomplie par l’entremise des logiciels conçus 

spécifiquement pour la tâche. Non seulement le logiciel assiste dans le dessin, mais peut aussi 

mettre à l’épreuve des circuits en reproduisant la fonction du circuit de façon artificielle, 

éprouvant les mêmes succès ou échecs dont le produit fini pourrait subir. La CAO ou La 

Conception Assisté par Ordinateur, concerne tous les logiciels permettant la réalisation de  

dessins  à  partir   d’un  PC    (exemple : Altium, Cadence, Cadstar, Orcad, Mentor Graphics, 

Pcad, …). Les outils de CAO de circuits imprimés cités ci-dessus sont désormais capables de 

traiter une large majorité des cartes. Pour les plus complexes, dotés de plusieurs boitiers haute 

densité, il faut cependant passer à des outils plus évolués. 

Aujourd’hui, la quasi-totalité des logiciels de CAO de circuits imprimés professionnels sont 

capables de router des cartes multicouches, de toutes tailles, intégrant des composants 

traversants et CMS. Le nombre des couches qu’ils peuvent traiter est quasi illimité. 

L’objectif, ici, est avant tout de réduire le temps de conception qui est parfois largement plus 

grevés par la recherche des bons composants  et de leur disponibilité, que par le temps de 

conception (placement, analyse d’intégrité, routage). 

2.1    Saisie du schéma  

Les logiciels de saisie de schéma nous permettent de dessiner les schémas électroniques en 

posant sur une feuille, des objets tout faits qui représentent les composants que l'on rencontre 

en pratique (résistances, diodes, transistors, connecteurs, etc) et de les relier ensuite entre eux 

par des fils de liaison (Figure 3). Certains logiciels de saisie comportent des bibliothèques de 

composants bien fournies (6000 composants par exemple), d'autres nous obligeront à créer 

nous-mêmes beaucoup de composants (bibliothèque d'origine de "seulement" quelques 

centaines de composants). Les logiciels professionnels permettent de produire un fichier 
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spécial appelé Netlist, qui décrit dans un simple fichier texte, l'ensemble des composants 

utilisés et les connections effectuées entre eux durant la saisie du schéma. Ce fichier Netlist 

peut ensuite être récupéré par un logiciel de routage, qui sait donc tout de suite quels 

composants devront être placés sur le circuit imprimé et comment ils devront être reliés entre 

eux. 

 

Figure 3 - Exemple de schéma d’un récepteur VHF avec le logiciel PCBEditor. 

2.2    Simulation 

La simulation permet d'observer le comportement d'un montage électronique, en appliquant 

des signaux spécifiques à des emplacements "stratégiques", et en regardant la forme des 

signaux à l'aide d'appareils de mesure virtuels (analyseur de spectre, oscilloscope, voltmètre, 

analyseur logique, etc). 

2.3    Routage (placement des composants)  

Le placement des composants et le routage des pistes est l'opération finale qui nous permettra 

de sortir sur papier notre dessin (Figure 4). 

Notons que les opérations de saisie de schéma et de simulation ne sont nullement requises 

pour pouvoir effectuer le routage, mais elles peuvent apporter un certain confort et une 

certaine sécurité.  
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2.4    L’autoroutage et l’autoplacement 

L'autoroutage est un procédé qui permet un tracé automatique des pistes entre les divers 

composants. Nous plaçons les composants selon notre souhait et nous lançons le routage 

automatique qui dessine les pistes les unes après les autres. Le routage des pistes doit 

répondre à certains critères. La main de l'homme est encore nécessaire pour les travaux 

critiques mais notons au passage que l'autoroutage donne en général de bons résultats quand il 

y a au moins deux couches de cuivre (circuit double face ou multicouches). 

L'autoplacement est un procédé qui permet le placement automatique des composants sur 

une zone de circuit imprimé préalablement délimitée. L'autoplacement peut concerner tout ou 

partie des composants de la platine, ce qui permet par exemple de fixer manuellement 

l'emplacement de certains composants (connecteurs au bord du circuit par exemple). 

 

Figure 4 - Routage du PCB avec le logiciel ExpressPCB. 

 

 

 

 

2.5     Production du fichier GERBER  
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Lorsque la conception du circuit imprimé est finalisée, il faut transmettre au fabricant les 

informations au sujet des différentes couches (layers) qui définiront notre carte de circuit 

imprimé. Le format GERBER est très utilisé dans l’industrie des circuits imprimés pour 

la spécification des tirages qui sont réalisés à l’aide d’un photo-traceur. Avant d’être 

transférés sur la carte, les motifs de chaque couche devront être reproduits sur des médias 

photographiques.  Il peut s’agir de motifs opaques sur pellicule transparente (aussi appelé 

positif) ou le contraire, c’est-à-dire de motifs transparents sur fond opaque (appelé 

négatif) selon le procédé de fabrication (procédé additif  ou soustractif) ou le type de 

couche (couche pour signaux, bus d'alimentation ou plan de masse). Tous les 

équipements industriels permettant de générer ces outils ou masques photographiques 

pour les circuits imprimés utilisent un format de fichier standard appelé GERBER. 

L'extension du nom des fichiers GERBER débute par la lettre G. Voici la liste des 

fichiers GERBER obtenus : 

- des fichiers .GTL  et .GBL  pour la description des motifs respectifs des 2 niveaux de 

conducteurs, soient celui du dessus (Top Layer) et celui du dessous (Bottom Layer) de 

la carte. 

- un fichier .GTO pour les motifs à imprimer sur le dessus de la carte (Top Overlay) s'il 

y a lieu. 

- un fichier .GDD pour les symboles correspondant aux trous à percer (Drill Drawing).  

Le format GERBER existe en 2 principales " variantes ", 

- le GERBER " simple ": Norme RS-274D, 

- et le GERBER " étendu ": Norme RS-274X.  

Les dossiers de GERBER produits dans le vieux format (RS-274D) manquent de 

l'information d'ouverture, qui doit être fournie séparément. La nouvelle norme (RS-274X) 

inclut l'information d'ouverture dans le dossier. 
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Editeur 

(distributeur) 

Nom 
générique du 

produit 

Formats de 
fichiers 
d’export 
supportés 

Routage 
interactif 

sans 
contrainte 

Routage 
simultané 
des pistes 

 

Analyse 
d’intégrité 
du signal 

Analyse 
et/ou 

visualisation 
3D 

Placement 
automatique 

Gestion des 
composants 

<<enterrés>> 

observations 

 

Altium 

 

Altium 
Designer 

6.8 

Gerber, 
ODB++, 

DXF, 
fichier 

CAMtastic 

 

Oui 

 

Oui 

 

Oui 

 

Oui 

 

Oui 

 

Non 

 

Produit intégré 
(schématique, placement-
routage) associé à un 
environnement de 
développement complet 
matériel (FPGA) et 
logiciel (compilation de 
code sur processeurs 
embarqués). 

 

 

CAD Design 

Software 

(JS 
Consultant 

EDA) 

 

 

Master 
PCB 

Designer 
Suite 

 

Gerber, 
ODB++, 

DXF 

 

Non 

 

Non 

 

Non 

 

Non 

 

Non 

 

Non 

 

Outil associé pour les 
MCM (Multi chip 
module) céramique, et 
LTCC; liens avec HFSS 
et les simulateurs 
d’AWR et Agilent. 

 

Cadence 
(ALS 

Design) 

 

 

Orcad 
PCB 

Designer 

 

 

Gerber, 
DXF 

 

Non 

 

Non 

 

Oui (avec 
signal 

explorer) 

 

Non 

 

Non 

 

Non 

 

La schématique Capture 
CIS intègre un 
gestionnaire de données 
composants; le routeur 
utilisé dans 

Orcad est celui d’Allegro. 

 

 

 

 

Cadence     
(et ALS 

Design pour 
l’entrée 

de gamme 
Allegro) 

 

 

 

Allegro 
PCB 

Design L 

 

 

 

 

Gerber, 
ODB++, 

DXF 

 

Oui 
(option) 

 

Oui 
(option) 

Oui Non Non Non Suite complète d’analyse 
d’intégrité de signal, 
intégrant l’analyse des 
paramètres S; outil 
d’optimisation de la 
consommation (via le 
placement des capacités); 
environnement de 
conception à entrées 
multiples (tables, VHDL 
et génération de 
schémas). 

Allegro 
PCB 

Design XL 

 

Oui Oui Oui Non Oui Oui 

Allegro 
PCB 

Design 
GXL 

 

Oui Oui Oui Non Oui Oui Idem ci-dessus; 
technologie de routage 
globale automatique, 
capable de prendre en 
compte des 

données de haut niveau. 
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CadSoft 

 

 

Eagle 4.1 

 

Gerber 
Non Oui Non Non Non Non Interface unique pour 

la schématique, et le 
placement-routage; 
gestion des vias 
aveugles et enterrés. 

 

Tableau 5 - Les caractéristiques de certains logiciels de CAO de circuits imprimés. 
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CHAPITRE 3 : LES RÈGLES DE CONCEPTION 

DES CIRCUITS IMPRIMÉS  
Les informations présentées dans ce chapitre sont extraites du document 3. 

Pour mener à bien l'étude d'un circuit, il faut tenir compte de plusieurs critères. Certains sont 

d'ordre électrique, thermique, mécanique, d'autres sont les normalisations, les contraintes de 

standardisation, les critères de fabrication et ceux relatifs aux composants. 

La difficulté d'une conception est due au fait que tous ces paramètres interviennent en même 

temps par leur interaction, ce qui oblige le concepteur à les connaître à fond avant d'agir, et 

surtout à avoir un bon entraînement mental à ce type de réflexion. En définitive, une bonne 

conception ne peut être réalisée que par un concepteur expérimenté. 

Ce chapitre indiquera seulement aux débutants quels sont les paramètres dont il faut tenir 

compte et comment les calculer. Ce sont uniquement les bases de la conception, le reste 

venant par la pratique d'une certaine gymnastique intellectuelle. 

Les compléments techniques à cet exposé peuvent être trouvés dans les normes françaises 

NCF 93713, UTE 93703 entre autres. 

3.1  Etude de tracé 

Le tracé des pistes, également appelé impression conductrice, est le cheminement de cuivre 

réalisant l'interconnexion électrique des composants. Cette liaison de cuivre relie donc deux 

ou plusieurs broches de composants. Dans le cas le plus simple. la piste va de la patte x à la 

patte y, et s’arrête à la proximité de la patte. La jonction à la patte sera terminée 

ultérieurement par un joint de soudure. On remarque que les ensembles trou/pastille sont les 

points de repère du tracé. Ils conditionnent l'insertion des composants, d'une part, et le 

passage des pistes d'autre part. Ce sont donc les trous qui serviront de référence à l'étude du 

tracé, et également aux contrôles dimensionnels. Les trous sont positionnés par l'implantation 

des composants. 

 

3.1.1 Paramètres électriques 

Une plaque de circuit imprimé est composée d'un support isolant sur lequel circulent des 

pistes de cuivre. 
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3.1.1.1   Isolement entre deux parties conductrices 

Aucune matière n'est parfaitement isolante et si on applique une différence de potentiel entre 

deux points, il existera toujours un courant de fuite circulant dans la matière entre les deux 

points. La connaissance des paramètres agissant sur les courants de fuite permettra de calculer 

les espacements minimums à respecter entre deux pistes pour que celui-ci soit sans effet sur le 

fonctionnement du montage électronique. 

Si le courant de fuite est important, (pistes trop rapprochées), on s'expose à un fonctionnement 

instable, à des signaux déformés par amortissement, des vitesses de transfert ralenties, et des 

réglages présentant des variations aléatoires. 

Ces résistances parasites existent entre deux pistes de la même face, ("Ris" = résistance 

d'isolement superficiel), et entre deux pistes à deux niveaux différents ("Rit" = résistance 

d'isolement transversal). Ces résistances sont fonction de la résistivité spécifique de la matière 

isolante et des souillures introduites par les procédés de fabrication du circuit qui jouent un 

rôle important sur la résistivité de surface. Il en est de même des conditions de 

fonctionnement de la carte électronique : humidité de l'air et altitude. 

Dans la mesure où le circuit est bien décontaminé après fabrication, et parfaitement sec, il est 

possible d'appliquer la relation suivante: 

,160
L

e
Ris ρ=

  
 

Où, 

- Ris = Résistance d'isolement superficiel, 

- ρ = Résistivité de la matière, spécifiée dans la norme NCF 93711, 

- e = Espacement des pistes (mm), 

- L = Longueur en regard des conducteurs parallèles. 

En ce qui concerne la résistance transversale, Rit, c'est une combinaison de la résistance de 

surface et de la résistance volumique. 

Le graphique de la figure 5 indique l'espacement minimal des conducteurs en fonction de la 

tension nominale entre eux, ainsi que la tension disruptive correspondante. On voit par 

exemple que deux pistes présentant une différence de potentiel de 100 V devront avoir un 

écartement minimum de 0,5 mm, ce qui donne une tension disruptive de 1 500 V en 50 Hz. ou 

de 2 500 V en courant continu. 
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Figure 5 - Distance d’isolement entre les pistes – Courant alternatif. 

 
3.1.1.2     Intensité admissible dans une piste, largeur d’une piste 

 
Une piste de section S donnée (épaisseur * largeur) et de longueur L, présente une résistance      

R = ρ * L/S (ρ étant la résistivité du métal). Quand un courant i circule dans une piste, il s'y 

produit un dégagement de chaleur tel que W = R * i² * t (dans le cas d'un courant continu) soit 

une puissance calorifique de P = R * I2 Watts. Or, on sait que 1W = 1J/s et que 1J = 1/4,18 

calories. Donc, à chaque seconde, il se produit 0,24 R * i2 calories dans la piste en question. 

Ces calories sont en partie absorbées par le support isolant qui est en contact étroit avec une 

face de la piste. Ce support joue le rôle d'un refroidisseur et les calories y sont évacuées par 

l'intermédiaire de la  jonction cuivre/support. Cette jonction n'offre pas une conduction 

thermique parfaite et il y a donc toujours une différence de température entre le cuivre et son 

support. 

 Si l'on suppose que le support reste à la température ambiante, la piste présentera alors une 

élévation de température. Mais puisque la température de la piste s'élève, la résistance de cette 

piste va augmenter selon la loi classique :  

R2 = R1 * [1 + (T2 -T1)]. 

Pour limiter l'échauffement qui risque de détériorer le circuit, il faut calculer la section de la 

piste de façon à diminuer la résistance R. L'épaisseur du cuivre étant fixe, on calcule la 
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largeur de la piste en fonction du courant à y faire passer (Figure 6). A titre indicatif, une 

densité de courant de 27 A/mm2 de section dans du cuivre de 35 µm d'épaisseur provoque un 

échauffement ce 8°C par rapport à l'ambiante. Des abaques pratiques permettent de faire un 

choix rapide de la largeur. 

 

 

Figure 6 - Elévation de la température sur circuit imprimé. 

 

3.1.1.3    Capacité et inductance entre deux pistes  
  

La capacité et l'inductance entre deux pistes parallèles provoquent des couplages qui ont pour 

résultat de reproduire sur une piste les informations qui circulent sur l'autre piste. C'est le 

phénomène de "diaphonie". Ce phénomène peut provoquer le mélange des conversations sur 

des lignes par effet de proximité. 

Au niveau de l'électronique industrielle, il y aura des erreurs d'adresse, d'information et des 

réactions d'une fonction sur l'autre. 
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a) La capacité parasite peut être calculée par la relation classique :  

,1085.8 12 Farads
e

S
ErC −×=  

Où, 

- C = capacité en Farads (F), 

- S = surface des pistes en regard (m2), 

- e = espacement des pistes (m), 

- Er = permittivité relative de l'isolant (voir NCF 93 711, fiche particulière de la matière 

considérée). En général, Er< 5. 

 

b) L'Inductance est toujours présente sur deux pistes parallèles rapprochées, qu'elles 

soient sur la même face ou sur deux couches différentes. Le mode de calcul étant 

relativement complexe, il est pratique d'utiliser les graphiques existants publiés dans le 

guide UTE C 93 703 (Union Technique de l'Electricité). 

3.1.2 Paramètres mécaniques et thermiques 

3.1.2.1   Adhérence des pistes 

L'adhérence d'un conducteur à son support dépend d'un grand nombre de facteurs parmi 

lesquels se trouve la surface de contact cuivre/support. 

Cette force d'adhérence est diminuée à chaque opération thermique, (traitements de surfusion, 

étamage soudure, cuisson de sérigraphie, etc.). La perte d'adhérence peut être telle que la 

force qui maintient la piste en place n'est plus suffisante. Dans ce cas, la piste se décolle de 

son support, même avec un effort très faible, (par exemple retouches au fer à souder, 

dilatation du cuivre lors de l'étamage). 

Pour éviter ce problème, il est conseillé d'augmenter dans la mesure des possibilités la largeur 

des pistes. 

3.1.2.2   Adhérence des pastilles 

Le problème est le même pour les pastilles. En effet, quand un trou est percé dans une pastille, 

il reste une couronne de cuivre autour du trou, et c'est cette plage de cuivre qui lie la pastille 

au support. La force d'arrachement d'une pastille est souvent spécifiée pour un diamètre donné 

mais il n'y a pas ici de corrélation linéaire entre cette force et la surface. Par suite, des 

modifications aléatoires apportées au moment du perçage, et tendant à diminuer l'adhérence. 

Ces modifications sont prépondérantes sur des pastilles de faible diamètre et négligeables sur 

les pastilles de grand diamètre. On cherchera donc à utiliser des pastilles à grande surface de 

contact, soit un certain rapport diamètre (pastille) / diamètre (trou) ou encore l'utilisation de 
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pastilles carrées ayant le même encombrement en x et y qu'une pastille ronde, mais offrant 

une plus grande surface de jonction au support. 

 

3.1.2.3   Surface de cuivre importante, plan de masse 

Lorsqu'il est nécessaire d'établir un plan de masse électrique, il est logique de laisser une 

grande surface de cuivre. Cette méthode est parfaitement valable mais à condition de prévoir 

un quadrillage de cette surface. Cette configuration ne modifie pas les phénomènes électriques 

mais elle est avantageuse au point de vue thermomécanique. En effet, si la température de la 

plaque augmente de façon importante au cours du procédé de fabrication, la dilatation d'une 

grande surface de cuivre exerce une contrainte mécanique sur la matière isolante. Cette 

contrainte provoque une déformation qui se traduit par l'obtention d'une plaque voilée, 

(flèche, torsion). Ce défaut peut se produire pendant la surfusion, l'étamage, la soudure, la 

cuisson de sérigraphie. 

Quand la plaque est striée, les manques de métal à l'intérieur de la surface se présentent 

comme des joints de dilatation et réduisent considérablement les déformations. Cette 

technique offre un avantage supplémentaire: chaque surface sans cuivre est un point stable 

pour l’accrochage du vernis épargne soudure, point très intéressant quand l'épargne est 

réalisée sur une plaque recouverte d'étain-plomb électrolytique, lequel fond lors de la soudure. 

 

3.1.2.4   Freins thermiques  

Quand le procédé de fabrication comporte un système de soudure par méthode simultanée, 

(bain ou vague par exemple), certaines précautions doivent être prises pour faciliter la prise de 

soudure sur les pastilles de la face composants. 

La brasure qui arrive à cet endroit vient de la face inférieure en passant à travers le trou où 

elle se refroidit. Par conséquent, lors de l'arrivée de la goutte sur la pastille supérieure, sa 

réserve calorifique est fortement diminuée et l'opération de soudage est compromise si la 

pastille demande beaucoup de calories. 

Il faut alors prévoir sur la face éléments, à la conception, des pastilles s'échauffant facilement, 

donc présentant une faible masse métallique.  

La solution est simple, il suffit de diminuer le diamètre des pastilles et de les séparer des 

grosses pistes en établissant une fine liaison pastille piste. 
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Dans le cas d'un plan de masse réalisé sur la face éléments, le trou ne doit pas être placé en 

pleine zone cuivrée. Il faut dégager une pastille dans cette surface cuivrée et la relier à la 

masse par un petit pont de cuivre. 

On obtient ainsi autour de la pastille une zone de faible conductibilité thermique que l'on 

appelle "frein thermique". Cette zone permet un échauffement rapide de la pastille donc une 

soudure aisée. 

3.2 Critères de fabrication et normes 

3.2.1 Précision et classes de gravure 

Nous avons vu que les paramètres électriques et mécaniques imposent certaines 

configurations géométriques du tracé de l'impression conductrice : position des trous, largeur 

et isolement des pistes, diamètre des pastilles. Ces paramètres doivent être respectés pendant 

les opérations de fabrication du circuit, et on doit les retrouver sur la carte gravée car c'est à ce 

moment qu'ils deviennent opérationnels. 

A cet effet les cartes imprimées ont été classées selon les caractéristiques de gravure afin 

d'obtenir un système cohérent des dimensions des divers paramètres (Tableau 5). Les cinq 

classes établies servent de guide à l'étude d'un circuit et à sa fabrication. Nous donnons, ici, en 

exemple, un tableau récapitulatif des dimensions. 

 

    
 

  

 

 

 

 

 

 

 

Tableau 6 - Les critères d’appartenance à une classe des circuits imprimés. 

 

 

3.2.2 Sens et forme des pistes 

1 - 2 - 3 - 4 - 5 - 6 - (2 )
105 105 105 70 50 35
105 105 70 35 35 17,5
0,80 0,50 0,31 0,21 0,15 0,12

0,68 0,50 0,31 0,21 0,15 0,12

1,57 1,13 0,90
1,19 0,78 0,60 0,49 0,39 0,35

0,45 0,34 0,24 0,20      - d'une pastille d'un trou d'interconnexion (via) sur une face et celui du trou percé

Valeurs nominales maximales sur couches internes
Largeur minimale (mm) :

                 * trous non métallisés
                 * trous métallisés

ClassesCritères d'appartenance à une classe
Valeurs de conception

Epaisseur totale du cuivre sur faces (µm)

Espacement minimal (mm)
    - entre conducteurs,
    - entre conducteur et pastille ou plage,
    - entre pastilles d'interconnexion, entre plages

Différence minimale entre le diamètre (mm)  (1)    :
    - d'une pastille d'un trou d'insertion sur une face et celui du trou fini :

(1) Ces valeurs sont applicables aux cartes simple face (trou non métallisé seulement ) et aux cartes double face; 
pour les cartes multicouches,
(2) La classe 6 est donnée à titre prospectif
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La disposition du tracé influe beaucoup sur les procédés de fabrication. En réalisant certaines 

opérations telles que la sérigraphie. L’étamage au rouleau, la soudure, on remarque 

rapidement que la qualité obtenue est meilleure sur les pistes orientées parallèlement au sens 

de travail, que l'on appelle "sens machine". Sur le sens travers au sens machine, on rencontre 

des difficultés pour déposer de façon homogène l'encre de sérigraphie, ou pour réaliser 

correctement l'étamage et la soudure. (Obtention de gouttes, de court-circuit, démouillage, ...). 

Par conséquent, le concepteur du circuit doit organiser son routage pour obtenir une direction 

unique des pistes sur la face soudure. Cette direction sera le "sens machine". 

Sur l'autre face, les pistes seront perpendiculaires aux premières. 

On n'oubliera pas que les pistes en courbe prennent plus de place sur le circuit que les pistes 

en segments de droite. 

 

3.3 Conception implantation 

3.3.1 Positionnement des composants 

Le point de départ d'une implantation est relativement subjectif ; il n'y a en général pas de 

raison logique pour commencer par un composant plutôt que par un autre. Les solutions 

envisagées peuvent cependant influer directement sur le tracé des pistes en le rendant simple 

ou compliqué, ainsi que sur l'assemblage des éléments et procédé de fabrication. 

Chaque schéma électronique ayant des impératifs particuliers, nous ne donnons ici que des 

conseils généraux, 

- Sur le format de carte choisi, placer d'abord le connecteur. Celui-ci permettra déjà de 

faire une sélection des composants car on placera au plus près du connecteur "les 

composants d'interface", c'est-à-dire ceux dont les connexions doivent aller vers 

d'autres cartes. Les "composants autonomes" seront mis à l'autre bout de la carte. 

- Les potentiomètres dont le réglage se fait à l'aide d'un tournevis parallèlement à carte, 

seront placés en bord de carte afin qu'aucun autre composant ne s'oppose au réglage, et 

du côté donnant accès à la carte quand elle sera dans son rack. 

- Les composants sont implantés parallèles entre-eux, ce qui permet de bien les ranger 

donc de gagner de la place, et si possible ils seront parallèles au bord portant le 

connecteur, cette disposition est la plus favorable au passage des pistes vers la zone du 

connecteur. On remarque que cette configuration conditionne le sens de passage des 

pistes sur la face soudures. 
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- Les composants polarisés sont orientés dans le même sens ce qui diminue les 

hésitations et risques d'erreur à l'insertion. 

- Lorsque la place disponible est très réduite, il est possible de monter debout les petits 

composants ce qui autorise une grande densité de pose. Cela nécessite cependant de 

grandes précautions afin d'éviter les courts-circuits entre les fils verticaux. L'insertion 

devient délicate. 

- Certains composants ayant des effets de proximité, il est nécessaire de les implanter en 

veillant à dégager autour d'eux une zone de sécurité. Par exemple, une résistance de 

puissance produisant de la chaleur ne sera pas placée à proximité d'un composant 

sensible aux variations de température (un condensateur électrolytique par exemple). Il 

en est de même pour le rayonnement électromagnétique d'un bobinage ou l'effet de 

masse d'une grosse pièce métallique. 

- Il faut également considérer que deux composants ne doivent pas se toucher sous 

peine d'établir des courants de fuite voir des courts-circuits à l'usage. 

- Pour les mêmes raisons et pour une plus grande facilité de nettoyage après soudure il 

est conseillé d'éviter le contact des corps des composants avec la face supérieure du 

circuit imprimé (pieds de lavage). 

3.3.2 Positionnement des trous 

Au début de cet exposé, nous avons parlé du rôle des trous. Leur positionnement est 

conditionné par la géométrie des composants. 

En règle générale tous les composants ont leurs broches à un entre axe de 2,54 mm, multiple 

ou sous-multiple. Pour positionner les axes des trous d'un composant il suffira alors de repérer 

les points d'intersection d'une grille au pas de 2,54 mm (grille fondamentale). Ce guide de 

positions est très pratique et précis. C'est cette même grille qui servira de référence aux 

contrôles dimensionnels ultérieurs. La précision de position des trous est primordiale, car s'ils 

ne sont pas correctement placés, les composants ne peuvent plus être insérés normalement 

sans détériorations. A ce titre, on peut travailler selon les tolérances spécifiés sur le tableau 

des classes de fabrication. En ce qui concerne les composants à sortie axiale, comme les 

diodes, les résistances, certains condensateurs, l'entre axe des pattes est défini par le pliage de 

celles-ci. A ce sujet, on doit se rappeler qu'il ne faut pas plier au ras du corps de l'élément, 

cela risquerait de casser la jonction patte/corps et de donner ultérieurement un faux contact. 

La distance de pliage se calcule en fonction de chaque élément (Fig. 14 page 17), mais il faut 

arrondir la distance au pas supérieur pour que les deux pattes concordent avec la grille de 
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référence. Il est intéressant d'aligner les trous, car moins il y aura de dispersion, plus 

l'opération de perçage sera simple et rapide. 

En général, les composants sont fixés mécaniquement par le joint de soudure aux connexions, 

si leurs poids n’excèdent pas 7 grammes par connexion ; sinon il faut prévoir une vraie 

fixation mécanique par collage ou vis et collier par exemple. Mais dans ce cas, il faudra placer 

un trou supplémentaire à la conception. 

 

3.3.3 Routage des pistes 

Cette opération consiste à chercher le meilleur passage pour une piste circulant parmi les 

autres pistes et pastilles. 

C'est à ce niveau de la conception que le travail est le plus délicat car si les trous sont plus ou 

moins imposés par les critères des composants comme nous l'avons vu, les pistes, elles, 

doivent seulement remplir leur fonction de liaison. 

A ce stade du travail, il faut être très prudent et il est judicieux de n'implanter que quelques 

composants et d'établir leurs interconnexions. On avancera ensuite de proche en proche par 

petits groupes de composants ou fonction. 

Pour faciliter le travail, quelques conseils sont intéressants à suivre, 

- L'impression conductrice doit être répartie le plus uniformément possible à la surface 

de la carte. 

- Quand les pistes sont des segments de droites, il est possible de les ranger et de gagner 

de la place qui fait souvent défaut. On multiplie ainsi les possibilités de passage. 

- Les jonctions piste/pastille se font toujours selon l'axe du trou. On évitera de raccorder 

plus de deux pistes sur la même pastille, ainsi que les jonctions de pistes à angle aigu. 

- Les pistes d'une largeur supérieure à 10 mm seront striées. 

- Si le circuit étudié est une double face, réalisé avec métallisation électrolytique, on 

essaiera d'équilibrer les surfaces conductrices de chaque côté de la carte. 

- Cette disposition favorise l'obtention de dépôts d'épaisseurs identiques sur les deux 

côtés de la plaque. 

- Toujours dans le cas d'un circuit double faces, pour simplifier la recherche du routage 

en évitant les croisements, il faut définir sur chaque face un sens privilégié de 

parcours. Habituellement les pistes vont au connecteur sur la face soudure, et dans le 

sens perpendiculaire sur la face éléments. 



 

 

37 

 

CHAPITRE 4 : FABRICATION DES CIRCUITS 

IMPRIMÉS  
Les informations présentées dans ce chapitre sont extraites des documents 4,5 et 6. 

Le support des cartes électroniques est un circuit imprimé. Celui-ci est une plaque en époxy à 

la surface    de    laquelle   des     pistes    en    cuivre   sont    gravées.  Il   ne   faut  pas     

confondre  « circuit imprimé » qui désigne la plaque et les pistes sur lesquelles seront soudés 

les composants et « circuit électronique » qui désigne l’ensemble de la carte électronique. 

 

Constitution de la plaque : 

 

Figure 7 - La constitution de la plaque 

 

Un circuit imprimé est composé (figure 7), 

- D’un matériau conducteur du cuivre, 

- D’un matériau isolant en époxy, 

- D’une couche photosensible, 

- D’un film protecteur. 

Toute la phase de préparation de la plaque a pour but d’enlever la résine puis une partie de la 

couche de cuivre pour que le cuivre restant forme les pistes que nous avons définies dans 

l’étape conception avec les logiciels CAO. 
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4.1   La conception sur ordinateur 

Une fois le besoin analysé et le cahier des charges validé la première grande étape dans la 

réalisation d’une carte électronique est la conception, la simulation et le routage des différents 

composants de celle-ci. Il existe de nombreux logiciels de CAO gratuits  qui nous permettent 

de réaliser ces tâches facilement à titre d’exemple:  CiDess, DesignSpark PCB, 

DessElec2000, DIY Layout Creator, Eagle Lite, ExpressPCB, FreePCB, Fritzing, gEDA, 

KiCad, … ; ainsi que des logiciels de CAO professionnels comme Altium Designer 10,  

Master PCB Designer Suite, Orcad PCB Designer ou Eagle 4.1. 

On utilise d’abord des outils de simulations fonctionnelles et électriques. A cette étape, on ne 

prend donc pas encore en compte les composants proprement dits mais on établit les 

différentes fonctions du circuit selon le cahier des charges établi. 

4.2 Imprimer le typon  
 

Le typon est un dessin du circuit imprimé (pistes et pastilles) effectué sur un film transparent 

(Figure 8). Le typon sera utilisé pour réaliser le circuit imprimé par photogravure (prochaine 

étape). 

Le typon est donc produit d’après le routage effectué précédemment. 

 

Figure 8 - Exemple de typon 

 

Nous observons facilement comment seront les pistes. Il nous faut donc à présent réaliser le 

typon sachant que plus le support est transparent et plus l´encre est opaque, meilleur sera le 

résultat. 

Plusieurs techniques peuvent être utilisées, 
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- Impression laser sur transparent 

- Impression jet d´encre sur transparent spécial (micro-granulé) 

- Photocopie d´un original papier bien contrasté sur transparent photocopieur 

- Impression laser sur du calque 

- Impression jet d´encre sur du calque spécial jet d´encre 

 

Ces techniques sont assez accessibles en terme de coût et de facilité de mise en œuvre, en 

revanche la qualité du typon est limitée par la qualité d’impression des imprimantes. 

Pour réaliser des typons avec une forte densité, des pistes très fines et proches les unes des 

autres, d’autres techniques utilisées dans le monde professionnel et industriel sont 

disponibles. Ces techniques sont basées sur la photogravure. 

Cela consiste à réaliser un film positif du circuit sur un support mylar (niveau professionnel) 

ou aluminium (niveau industriel). 

Pour fabriquer ce film, il faut présensibiliser le support grâce à un aérosol spécial. Ensuite il 

faut l´insoler à partir du typon papier (lumière blanche ou UV suivant le type), puis le 

développer avec du révélateur spécial. Le résultat est un noir très opaque sur un support bien 

transparent aux UV, et tout cela avec la précision de la photogravure qui est bien au-delà des 

300 ou 600 dpi de nos imprimantes. C´est une technique complexe et onéreuse qui n´est pas 

vraiment justifiée pour l´amateur, car elle nécessite un matériel et un savoir-faire particulier.  

Maintenant que nous avons réalisé le typon, nous allons pouvoir l’utiliser pour procéder à 

l’insolation. 

 

4.3 L’insolation de la plaque époxy 

Après avoir retiré le film protecteur de la plaque époxy, la résine se trouve à la surface. Cette 

résine a pour propriété de se modifier lorsqu’elle est exposée aux rayonnements Ultra Violet 

(UV), elle est dite photosensible. Cette propriété est intéressante car il suffit d’isoler des UV 

certaines parties de cette résine pour qu’elle ne soit pas modifiée. On comprendra l’intérêt 

d’avoir modifié une partie de cette résine lors de la révélation (étape suivante). Il va donc 

falloir exposer notre plaque aux UV (c’est ce qu’on appelle l’insolation de la plaque). 

Pour cela on utilise une insoleuse. Une insoleuse est principalement constituée de puissants 

tubes néon UV et d’une vitre totalement transparente sur laquelle on déposera la plaque 

(Figure 9). Une fois fermée elle ne laisse pas passer la lumière car les UV présentent un 

danger particulièrement pour nos yeux. 
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Figure 9 – Une insoleuse. 

 

Maintenant nous allons utiliser le typon que nous avons obtenu dans la phase précédente. On 

l’intercale entre les tubes UV et le côté résine de la plaque comme illustré ci-dessous (Figure 

10). 

 

Figure 10 - Placement des différents éléments pour l’insolation.  

On comprend à présent mieux pourquoi il faut que les pistes imprimées sur le typon soit très 

noires et donc très opaques aux UV et le reste du support très transparent afin de laisser la 

voie libre aux UV. Ainsi la résine sera modifiée pendant la phase d’insolation uniquement sur 

les zones de la plaque exposées aux UV donc toutes celle où il n’y aura pas de piste dessinée, 

alors que les parties non exposées resteront intactes (Figure 11). 
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Figure 11 - Après l’insolation, le dessin typon apparaît sur la résine photosensible.  

 

4.4 La révélation 

Le révélateur est un produit chimique que l’on peut le fabriquer soi-même, puisqu´il s´agit 

d´une simple solution de soude caustique à 7g/l comme le Destop (produit pour déboucher les 

canalisations). Cependant, on la trouve à l’achat déjà dosée. Sa manipulation nécessite des 

précautions comme le port de gants. L’efficacité du révélateur est meilleure quand il est tiède. 

On doit maintenant placer la plaque dans un bac contenant le révélateur. 

Le révélateur va dissoudre les zones de la résine qui ont été détruites pendant l’insolation. La 

couche de cuivre va progressivement apparaître autour des pistes qui sont encore protégées 

par la résine. Une fois la plaque révélée, elle est sortie du bac et rincée à l’eau. 

La carte est plongée dans un révélateur positif (bain d’hydroxyde de sodium faiblement dosé), 

quelques secondes suffisent pour dissoudre la résine exposée aux UV et faire apparaître le 

cuivre indésirable (hors pistes et pastilles) (Figure 12) : 

 

 

Figure 12 - Après révélation, l’apparition du cuivre indésirable (hors pistes et 

hors pastilles).  
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4.5 Graver le circuit imprimé 
 

Notre plaque est plongée dans un bac à graver qui contient un produit acide : le perchlorure de 

fer. Cet acide va dissoudre le cuivre autour des pistes protégées par la résine (Figure 13). Le 

Perchlorure de Fer suractivé est un liquide de couleur marron très foncé. On l´utilise pour 

graver les circuits imprimés car il a la particularité de détruire (par réaction chimique) tout le 

cuivre qui n´est pas recouvert de résine photosensible. Cela a pour conséquence de ne laisser 

sur la platine que les pistes qui nous intéressent. 

 

Figure 13 - Le perchlorure de fer attaque le cuivre visible (hors pistes et pastilles).  

 

4.6 L’élimination  

Une fois votre circuit gravé, il reste à enlever les traces de résine qui subsistent sur les pistes 

protégées. Nous utiliserons pour cela du dissolvant, ou encore de l’acétone. Le but est 

d’obtenir un circuit avec des pistes bien nettes et sans aspérités (Figure 14). 

La carte est à nouveau plongée dans un bain d’hydroxyde de sodium, cette fois fortement 

dosé. Cette phase élimine la résine restante sur les pistes et pastilles du cuivre. 

 

 

Figure 14 - L’élimination de la résine sur les pistes et pastilles du cuivre. 
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4.7 L’étamage 
 

La carte est plongée dans une solution ionique à base d’étain (étamage à froid) qui se dépose 
sur le cuivre (Figure 15). 

 

 

Figure 15 - L’étain qui se dépose sur le cuivre 
 
Notre circuit imprimé est maintenant terminé il ne reste plus qu’à souder les composants pour 

former le circuit électronique. 

4.8 Mise en place et soudure des composants  
 

Il existe plusieurs technologies de composants, le circuit imprimé que nous avons conçu dans 

les étapes précédentes est destiné à accueillir des composants dit traditionnels. Mais il existe 

aussi des composants SMD. 

4.8.1 Les composants traditionnels 

Les composants traditionnels sont facilement manipulables à la main. Ils sont de taille 

moyenne et l’épaisseur des cartes est donc assez importante (Figure 16). 

 

Figure 16 - Carte électronique réalisée en composants traditionnels. 
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Les composants sont généralement placés manuellement. La soudure des composants 

s'effectue en manuel ou à la vague. 

4.8.1.1 Percer le circuit 

 Avant de souder les composants, il nous faut percer les pastilles. Ces trous correspondent à 

l’emplacement des pâtes des composants. Pour cela, on utilise une perceuse à colonne 

(figure17). 

On place le circuit imprimé sur le support puis on choisit la taille du foret en fonction des 

composants qui devront être soudés (entre 0.6 mm et 1.5 mm). 

 

Figure 17 - Perceuse à colonne. 

Une fois toutes les pastilles percées au bon diamètre, on va pouvoir souder les composants. 

4.8.1.2 Souder les composants 

A présent on doit placer les composants sur la plaque en s’aidant du schéma. Pour souder on 

utilise un fer à souder et de l’étain (Figure 18) car c’est un métal facilement manipulable et 

que sa température de fusion est assez basse (il fond facilement). 

 

Figure 18 - Fer à souder. 

 

La partie métallique s’appelle la panne, c’est la partie qui chauffe. 

On utilise l’extrémité de la panne pour faire fondre l’étain lors de la soudure. Cependant les 

soudures doivent respecter quelques règles (Figure 19), 
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- Approcher le fer et le fil de soudure de la pièce à souder. 

- Abaisser le fer sur la zone à souder 

- Chauffer la tige ou la patte en premier (1-2 sec). 

- Appliquer le matériel d’apport à la jonction de la tige et du côté opposé à la position 

du fer jusqu’à l’obtention de la soudure parfaite. 

- Retirer le matériel d’apport et ensuite le fer. 

- Laisser refroidir à la température ambiante, ne pas souffler 

 
Figure 19 - Les 4 étapes de soudure.  

 

Une mauvaise soudure peut par exemple conduire à des courts circuits si deux pistes sont 

reliées par erreur. 

Maintenant que nous avons détaillé la procédure de mise en place et de soudure des 

composants traditionnels, nous allons étudier celle, bien plus complexe, des composants 

SMD. 

4.8.2 Les composants SMD 

Cette technologie de composant est destinée au monde industriel. Elle implique la mise en 

œuvre de nombreuses machines et les étapes de fabrication sont différentes de celles que nous 

avons détaillées pour les composants traditionnels. En voila les grandes étapes. 

 

4.8.2.1 Dépôt de patte 

On dépose un masque sur le circuit imprimé, les trous du masque correspondent aux endroits 

où les composants seront soudés (Figure 20). 



 

 

46 

 

Figure 20 - L’application de la patte sur le circuit imprimé par une machine. 

4.8.2.2         Placements des composants 

Une machine appelée placeur dispose les composants SMD sur le circuit imprimé (Figure 21). 

Cela permet de placer plus de 10000 composants à l'heure. On comprend mieux l’utilité d’une 

telle machine lorsque l’on sait qu’une carte mère d’ordinateur peut contenir plusieurs 

centaines de composants. 

 

Figure 21: machine de placement.  

 

4.8.2.3       Soudure 

Le soudage des composants s'effectue soit dans un four à infra rouge soit en « phase vapeur ». 

L'avantage du four à infrarouge est sa rapidité alors que la précision de soudure est meilleure 

dans le cas du four en « phase vapeur ». 
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A. Soudure à la vague : On pose sur la machine la carte et les éléments à souder 

 qui sont préchauffés avant d'être passés au raz d'une vague de soudure à l'étain. La quantité 

de soudure dépend de la hauteur du circuit par rapport à la vague. 

 

B. Soudage à infra rouge : Ce four ce présente sous la forme "tunnel chauffant". 

On place les cartes à souder sur un convoyeur. La température du four est généralement 

programmable en fonction des besoins. 

 

 

Figure 22 - Four de soudage. 

 

C. Soudage en phase vapeur : Ce four est constitué d'un liquide inerte fluoré (Figure22). 

On chauffe le produit à 215° à cette température il produit une vapeur dans laquelle on 

trempe le circuit à souder. Ensuite on sort le circuit de la vapeur pour le refroidir. 

Contrairement à la soudure au four à infra rouge, la qualité des soudures n'est pas 

influencée ni par la taille des composants ni par leur couleur. 
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CHAPITRE 5 : PRÉSENTATION DU LOGICIEL  

ALTIUM DESIGNER 10 
Les informations présentées dans ce chapitre sont extraites du document 7. 

Altium Designer est un outil complet de développement de produits électroniques incluant, 

      - un outil de routage PCB, 

      - un outil de simulation SPICE, 

      - un outil de développement FPGA, 

      - et un outil de développement de code embarqué. 

 

On peut démarrer ces différents outils depuis la page de démarrage de l’outil (Figure 23). 

 

 
Figure 23 - Page de démarrage d’Altium Designer 10. 
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5.1 Flot de conception d’une carte électronique 

La figure 24 décrit le flot typique de conception d’un circuit imprimé (PCB). Un projet PCB 

contient deux documents, 

- Une schématique, décrivant le schéma électrique de l’application. Les composants 

électriques sont représentés par des symboles et reliés par des interconnexions 

électriques. 

- Un document PCB, décrivant le placement physique 

des composants sur la carte et le routage des 

interconnexions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 24 - Flot de conception d’un circuit imprimé. 

Ces deux documents sont liés. A chaque composant électronique, on associe un symbole 

électrique et une empreinte sur un circuit imprimé. La première phase consiste à définir le 

schéma électrique. On sélectionne dans une librairie les différents symboles électriques des 

composants, on leur attribue des empreintes et on les relie. Après une validation électrique, le 

 
Création d’un projet PCB 

   Saisie  de   la  schématique 

                   Lien  
       symboles - empreintes 

   Transfert du schéma sur 
       le document PCB 

Spécification carte et 
    règles de routage 

     Placement composants/ 
          Routage PCB 

          Vérification routage 
                    (DRC) 

          Fichier de sortie 

    Document de 
    schématique 

Document de 
  routage 

      Vérification électrique 
                     (ERC) 
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document de routage PCB, qui a été au préalable spécifié, est mis à jour en fonction de la 

schématique. Les empreintes des composants sont déposées aléatoirement sur la surface de 

routage, les interconnexions entre les circuits apparaissent sous forme de liens virtuels. Les 2 

étapes qui suivent sont, 

- Le placement des composants sur la carte. 

- Le routage des interconnexions, qui vont être matérialisées par des lignes métalliques. 

A la fin de ces deux phases, une vérification de la correspondance entre le routage et la 

schématique et du respect des règles de routage (DRC) est appliquée fin de valider le design. 

Une fois le design validé, des fichiers de sortie peuvent être produits pour réaliser les 

différents masques servant à fabriquer la carte. Les parties qui vont suivre décrivent comment 

réaliser ces différentes étapes sous Altium Designer. 

 

5.2 Créer un projet PCB 

Sous Altium Designer, un projet est composé d’un ensemble de documents reliés au design. 

Les projets PCB ont l’extension name.PrjPCB . Il s’agit d’un fichier ASCII listant tous les 

documents et les réglages de sortie (pour l’impression et CAM). 

Pour créer un nouveau projet, cliquez sur File>New>Project>PCB project depuis la fenêtre 

de démarrage d’Altium. Renommer le nouveau projet en conservant l’extension .PrjPCB  et 

indiquer le chemin d’accès sur le disque, en cliquant sur File>Save Project as. Pour l‘instant, 

le projet est vide, aucun document n’a été ajouté. La prochaine étape consiste à créer la 

schématique et de l’ajouter dans le projet. 

 

5.3 Saisie d’une schématique 
5.3.1 Création d’une schématique 
 
On créé une nouvelle schématique en cliquant sur File>New>Schematic. Une feuille de 

saisie de schématique vierge apparaît, nommée Sheet1.SchDoc (Figure 25), qui est 

automatiquement ajouté au projet dans la liste Source documents. On renomme la fiche avec 

File>Save As. Il est possible d’ajouter une schématique existante au projet à l’aide d’un 

clique droit au dessus du nom du projet dans le panneau Projects et en sélectionnant Add 

Existing to Project. 
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Figure 25 - Création d’une nouvelle schématique. 

Avant de démarrer la saisie de la schématique, il est nécessaire de paramétrer les options de la 

fiche (Figure 26). Aller dans Design>Document Options puis dans Sheet Options. 

Sélectionner le format de la fiche (exemple : A4). Dans Units, sélectionner le système 

métrique pour les unités, puis OK . 

 

Figure 26 - Modification des options du document de schématique.  

5.3.2 Saisie de la schématique 

Maintenant, il est possible de saisir une nouvelle schématique. Dans un premier temps, il est 

nécessaire de localiser les composants dans les différentes librairies fournies par l’outil, puis 

de charger ces librairies. Cliquez sur Design>Browse Libraries pour afficher le panneau 
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d’exploration des librairies. Le bouton librairie est aussi disponible sur le bord droit de la 

fenêtre. La fenêtre présentée figure 5 apparaît en cliquant sur ce bouton. Il existe différents 

moyens de retrouver un composant : 

- Soit en cliquant sur le bouton Search. Une fenêtre de dialogue s’ouvre permettant une 

recherche à partir de quelques critères. 

- Soit en cherchant dans le contenu d‘une librairie (par défaut, la librairie Miscellaneous 

est chargée) (Figure 27). 

Différentes informations sont reliées à chaque composant : un symbole, une empreinte, un 

modèle pour la simulation électrique, pour la simulation d’intégrité de signal. 

Pour placer un composant sur la schématique, sélectionnez ce composant dans sa librairie, 

puis appuyez sur le bouton Place. Vous pouvez ensuite déplacer le composant qui reste 

flottant et le placer à l’endroit voulu par un simple clic ou en appuyant sur Entrée. Lorsqu’il 

est flottant, on peut le faire tourner à l’aide de la barre d’espace, éditer ses propriétés à l’aide 

de la touche Tab, changer son orientation à l’aide de la touche x ou y. 

 

Figure 27 - Panneau librairie 

Une fois le composant placé, il est possible d’afficher ses caractéristiques par un double clic, 

de l’effacer en le sélectionnant et en appuyant sur la touche Supprimer. Il est possible de 

faire tourner un composant en le sélectionnant et en appuyant sur la barre d’espace (ou en 

allant dans Edit>Move). En double cliquant sur le composant, on fait apparaître ses 

propriétés. Dans cette fenêtre, on peut éditer et modifier le nom, les valeurs, le boîtier, le 

brochage et d’autres propriétés. 
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Une fois les composants placés, on peut les connecter. Pour cela, cliquez sur Place>Wire ou 

sur le bouton. Cliquer ou appuyer sur entrée pour connecter la première extrémité des fils, 

faire de même pour connecter la seconde extrémité. Une fois les composants interconnectés, 

on peut les déplacer sans casser les connexions en cliquant sur Edit>Move>Drag. Vous 

pouvez le faire en bougeant normalement le composant tout en appuyant sur la touche 

Control. 

Enfin, il faut nommer les nœuds. Pour placer des labels de nœuds, cliquez Place>Net Label 

et placer le sur le fil à nommer. Une croix rouge apparaît quand le logiciel détecte un nœud à 

nommer. Vous pouvez entrer le nom du label en cliquant sur tab si le label est encore flottant 

ou en double cliquant dessus. 

 

5.3.3 Compilation de la schématique  

Altium propose différents moyens de vérification de la schématique construite (electrical 

rules, matrice de connectivité, comparateur, …). Tout cela se paramètre à partir de 

Project>Project Options. La fenêtre de dialogue ci-dessous s’ouvre, permettant de 

configurer le rapport d’erreur pour toutes les fautes possibles. 

La fenêtre Error Reporting  permet de configurer le niveau de sévérité d’une violation de 

connectivité donnée. La fenêtre Connection Matrix permet de vérifier les connections 

électriques entre broches, ports ou fiches et de configurer le niveau de sévérité des violations 

associées. Les carrés de couleur indiquent les niveaux de sévérité, qui peuvent être modifiés 

en cliquant dessus. 

On commence par compiler le projet et vérifier si il y a ou non des erreurs en cliquant sur 

Project>Compile PCB Project. Les éventuels messages d’erreur ou d’avertissement 

s’affichent dans le volet Messages (qu’on fait apparaître sous la fenêtre de schématique en 

cliquant sur View>Workspace Panels>System>Messages. S’il n’y a pas eu d’erreurs, le 

volet Messages reste vide. 
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Une fois la schématique validée, il est possible de transférer la schématique électrique sur le 

PCB. En cliquant sur Reports/Bill of Materials, une fenêtre de dialogue permet de 

paramétrer le fichier de sortie contenant la liste des composants (Figure 28). 

Figure 28 - Configuration de la vérification de la schématique. 

  

5.3.4 Routage PCB 
 

Le routage PCB se fait toujours en étroite relation avec la schématique. La schématique 

permet de définir les connexions électriques entre les différents composants. Pour pouvoir 

faire le lien entre la schématique et le PCB, les composants des librairies sont non seulement 

définis par un symbole de schématique mais aussi par une empreinte de PCB. Une fois la 

saisie de la schématique terminée et validée, on peut mettre à jour le PCB. Les composants 

avec leurs empreintes physiques apparaissent à la surface du PCB, une connexion virtuelle 

entre deux composants connectés apparaît entre leurs pads. 

Le routage consiste d’abord à placer les composants puis à router les interconnexions 

physiques entre les composants. Toute modification du routage qui brise la correspondance 

avec la schématique conduit inévitablement à une erreur, qui sera détecté par le logiciel de 

routage. 

5.4 Création d’un nouveau document PCB 

Avant de transférer le design depuis l’éditeur de schématique vers l’éditeur PCB, il faut créer 

un PCB vierge, dont on défini la taille, le nombre de couches, les épaisseurs, et les règles de 

routage. Pour cela, on va utiliser le PCB Board Wizard. On y accède en retournant dans la 
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fenêtre initiale Printed Circuit Board Design et cliquez sur PCB Document Wizard 

(Figure29). On peut aussi y accéder depuis le volet Files à droite de la fenêtre, dans New 

From Template et en cliquant sur PCB Board Wizard. 

Figure 29 - PCB Board Wizard. 

Une fenêtre finale s’affiche indiquant que vous avez achevé la définition de votre carte, vous 

pouvez cliquer sur Finish. La fenêtre ci-dessous s’affiche, l’éditeur de PCB vient de s’ouvrir 

(Figure30). C’est depuis cet éditeur que nous allons pouvoir router la carte. 

 
Figure 30 - Nouveau document PCB produit avec PCB Board Wizard. 

 
Le PCB apparaît en noir sur une feuille blanche, avec les dimensions de la carte autour. Sur la 

base inférieure de l’éditeur apparaissent les couches physiques, mécaniques et de masque qui 

nous permettront de router la carte. Cette présentation ne sera pas très adaptée pendant le 
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routage. Pour la modifier, allez dans Design/Board Options. En désélectionnant la case 

Display Sheet, on supprime la feuille. 

A partir de cette fenêtre, on peut aussi configurer la grille (Visible Grid ), c'est-à-dire le 

quadrillage visible sur l’éditeur de PCB, ainsi que la grille électrique (Electrical Grid ). Celui-

ci nous aidera durant le placement des composants puisque ceux-ci se fixeront 

automatiquement sur cette grille (Snap Grid). En général, on configure le champ Visible 

Grid  avec la valeur de l’espacement entre 2 broches d’un boîtier. 2.54 mm est une valeur 

standard. Pour l’ensemble des dimensions des grilles, il est préférable d’employer des sous 

multiples et des multiples d’une même valeur. Si la taille de la grille est de 2.54 mm, il 

convient de fixer la taille de Snap Grid à 0.254 mm ou 0.127 mm. 

Nous devons définir l’empilement des différentes couches du PCB. Pour cela, on clique sur 

Design / Layer Stack Manager. L’écran ci-dessous s’affiche. Si seulement deux plans de 

signaux ont été définis, la figure 31 ne doit pas inclure les plans Internal Plane 1 et 2. Ils 

n’apparaissent que si on a inclus 2 plans d’alimentation. En cliquant sur Internal Plane 1 ou 

Internal Plane 2, on peut connecter ces plans à un nœud donné (alimentation ou masse de 

préférence). 

 

Figure 31 - Configuration de l’empilement des différentes couches du PCB. 

 

Nous venons de finir le paramétrage de base de la carte. Maintenant, nous allons inclure cette 

carte au projet. On peut commencer par sauvegarder le PCB (extension .PcbDoc). Le fichier 

apparaît dans l’arborescence du projet comme un Free Documents et n’appartient pas encore 

au projet, même si vous l’avez sauvé dans le même répertoire que votre projet. Pour l’inclure 
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dans le projet, dans l’arborescence projet , faites un clic droit sur le nom du projet, puis Add 

Existing To Project et choisissez votre document PCB. Celui-ci sera automatiquement 

intégré au projet. 

5.4.1   Transfert schématique vers le document PCB 

Le PCB est pour l’instant vide. Il faut maintenant transférer la schématique à votre document 

PCB. Cette opération va transférer l’ensemble des composants de la schématique à votre PCB, 

sur lequel les empreintes des composants et leurs connexions vont apparaître. Pour cela, 

retournez sur la schématique. Cliquez sur Design/Update PCB Document xxx.PcbDoc. La 

fenêtre suivante s’ouvre. 

Figure 32 - Transfert de la schématique vers le document PCB. 

 
L’ensemble des composants et des nœuds apparaît. Pour réaliser le transfert, cliquer sur 

Validate Changes puis Execute Changes. Si tout se passe bien, aucune erreur n’est indiquée 

sur cette fenêtre et on peut la fermer. 
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Figure 33 - Document PCB après transfert de la schématique. 
 

Les composants sont placés en dehors de la carte (Figure 33). La prochaine opération sera le 

placement des composants, qui va consister à les placer judicieusement sur la carte afin 

d’optimiser le routage. 

5.4.2   Placement des composants 

Le placement doit se faire en commençant à imaginer à quoi doit ressembler le routage (figure 

34). Une fois le placement achevé, l’éditeur de PCB doit ressembler à quelque chose de 

similaire à la figure ci-dessous. Par défaut, les composants se situent sur la face avant de la 

carte (ou Top Layer). 

 
Figure 34 - Placement des composants. 
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5.4.3 Le routage de la carte 

Le routage de la carte consiste à relier les composants par des pistes gravées sur une couche 

physique. On dispose de 2 couches ou faces : 

- La face avant ou Top Layer : en général il s’agit de la face où sont placés les 

composants 

- La face arrière ou Bottom Layer : pour des composants traversants, il s’agit en général 

de la face sur laquelle les soudures des broches des composants. 

Avant de commencer à router, voyons les différentes couches proposées en cliquant sur 

Design/Board Layers & Colors. On distingue les couches physiques (celles sur lesquelles on 

va effectivement routé) des couches mécaniques et de masque qui vont servir à graver sur les 

couches physiques des indications utiles au concepteur ou au fabricant. On les distingue 

uniquement parce qu’elles n’ont pas le même rôle et parce qu’on ne voudra pas forcément 

graver l’ensemble des indications. Les couches physiques que nous allons employer sont les 

couches Top Layer et Bottom Layer. En décochant une couche, on peut la rendre invisible. 

Le routage doit se faire en respectant un ensemble de contraintes appelées design rules. 

Altium Designer propose de router sous contraintes, c'est-à-dire qu’il vérifie durant le routage 

si les règles de design sont respectées. Pour les configurer, cliquez sur Design/Rules. La 

fenêtre suivante apparaît. 

 

Figure 35 - Configuration des règles de design. 
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Remarque : avant de router, assurer vous de la couche sur laquelle se situe le composant. Par 

défaut, il est placé sur le Top Layer. Si vous utilisez un composant traversant, alors la couche 

de routage sera en général le Bottom Layer. Si c’est composant monté en surface, alors la 

couche de routage sera en général le Top Layer. Vous pouvez modifier la couche sur laquelle 

est monté le composant en double cliquant sur le composant pour accéder à ses propriétés. 

5.4.4 Validation du routage 

Une fois le routage terminé, il convient de s’assurer que les règles de dessin ont été 

respectées. Normalement, le routeur automatique nous indique les violations de règles de 

design (Figure 36). Cette validation s’appelle Design Rule Check (DRC). On y accède en 

cliquant sur Tool/Design Rule Check. 

 
Figure 36 - Configuration du DRC. 

A partir de la fenêtre qui s’ouvre, on peut configurer le rapport d’erreurs qui sera généré et les 

erreurs qui seront reportées. Une fois que cela est configuré, on clique sur le bouton 

Run/Design Rule Check. Une fois l’opération de DRC effectuée, le rapport de DRC s’ouvre 

dans une page HTML (Figure 37). 
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Figure 37 - Rapport de DRC. 

 

5.5 Création des fichiers de sortie  

Altium propose différents fichiers de sortie standards tels que les fichiers Gerber. Créer un 

fichier de sortie standard est très utile lorsque le designer du PCB envoie son design au 

fabricant car cela assure la compatibilité des formats. Le fabricant pourra vérifier le design 

avec ces propres outils et apporter des modifications. Néanmoins, la fabrication consiste à 

transférer l’image de chaque couche du PCB sur des masques. Une manière simple d’assurer 

ce transfert est de créer une image à l’échelle du PCB. 

5.5.1 Génération des images des masques 

Pour cela, on va exporter chaque couche au format PDF, à l’aide de l’imprimante PDF 

(Figure38). Ces documents pourront être directement envoyé à l’impression et générer ainsi 

les masques. Si on réalise un board 2 couches, on réalisera 2 images : une pour la face avant, 

l’autre pour la face arrière. Dans un premier temps, il convient de fixer les paramètres de la 

page, et notamment de fixer ses dimensions. Cette étape est nécessaire pour avoir un dessin à 

l’échelle. Pour cela, cliquez sur File/Page Setup… Choisissez l’orientation de la page, 

choisissez un mode de couleur noir et blanc (option Mono). Pour avoir un dessin à l’échelle, 

sélectionnez Scaled Print dans l’option Scale Mode et fixez Scale à 1. 
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Figure 38 - Couches visibles lors de l’impression. 

Enfin, cliquez sur le bouton Advanced. La fenêtre ci-dessous apparaît, listant les couches et 

les informations qui seront visibles lors de l’impression. Pour supprimer des couches ou en 

ajouter, appuyez sur le bouton droit de la souris et cliquez sur Delete ou Insert Layer. 

Cochez la case Holes pour faire apparaître les trous de perçage à l’impression. Cette option 

n’est utile que pour des montages traversants. 

Pour vérifier ce qui va être imprimé, cliquez sur File/Print Preview. On obtient l’image 

suivante. Pour la sauvegarder au format PDF, cliquez sur Print  et utilisez l’imprimante PDF. 

On obtient ainsi le masque pour le top layer. 
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CHAPITRE  6 
CONTRIBUTION  - RÉALISATION D ’UN TNC 

La description du Mini-TNC est extraite du document 8.  

6.1 Objectif de l’application  

L’objectif de cette application est de réaliser tous les étapes de conception que nous avons 

traité à travers les chapitres précédents, de la saisie de la schématique à la génération des 

fichiers Gerber.   

6.2 Description du Mini-TNC 

Le Mini-TNC est un TNC à base de PIC88 qui décode les paquets APRS et fait le routage au 

port COM. il a deux connecteurs D9 pour des communications extérieures. On fournit  un 

connecteur D9 (J1) pour votre émetteur-récepteur et l’autre connecteur D9 (J1) pour la 

connexion au PC afin d’envoyer les données reçues à l’ordinateur en utilisant un câble simple 

en série. Le Mini-TNC peut se mettre en tension soit par +5V d’une USB (J3) soit par le 

connecteur de Radio D9 avec +8V jusqu’à +12V DC. Un régulateur interne (78L05) fournit 

+5V pour les circuits numériques. La consommation actuelle est bien au dessous de 20 mA 

(selon les LEDs). Il utilise un conducteur RS232 standard à l'interface avec le  PC. Nous 

exigerons qu'un câble en série configure les paramètres internes du PIC88 (Figure 39). 

 

Figure 39 - La carte électronique du Mini TNC complète. 
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Les connecteurs du Mini-TNC qui permettent son fonctionnement (Figure 40).   

 

                            USB (+5V)                 vers PC                          vers Radio 

Figure 40 - Les connecteurs du Mini-TNC. 

6.3 Flot de conception du Mini-TNC 

6.3.1    Saisie de la schématique  

Le schéma électrique du Mini-TNC est le suivant : 

 

Figure 41 - Schéma électrique du Min-TNC 

 

 Nous abordons l’application par la saisie du schéma sur le logiciel Altium Designer  

(Figure42): 



 

 

66 

 

Figure 42 - Saisie du schéma du Mini-TNC par Altium Designer 10. 

Après, nous générons une Netlist contenant tous les composants du schéma sous le format 

suivant (Figure 43) : 

 

Figure 43 - Génération de Netlist sous Altium Designer 10 

 

 



 

 

67 

 6.3.2   Transfert vers le PCB  

Après la validation du schéma, donc l’absence des erreurs, il est possible maintenant de 

transférer le schéma vers le PCB. En créant une fenêtre de dialogue qui permet de paramétrer 

le fichier de sortie contenant la liste des composants, une liste apparaît comme ci-dessous 

(Figure 44) : 

 

Figure 44 - Transfert des composants en empreintes Bill Of Materials.  

Après le transfert effectué, et l’attribution de chaque empreinte à un composant, on arrive à 

l’étape délicate de la conception des circuits imprimés, le routage des composants, qui doit 

suivre des règles et des contraintes qu’on a déjà signalé au  chapitre 3 (figure 45). 

La compilation du routage se fait pour signaler les erreurs commises et l’endroit de l’erreur 

dans le circuit. Un exemple de routage effectué selon les règles de conception, ainsi que le 

rapport DRC après compilation sont présentés dans la figure suivante, 
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Figure 45 - Le circuit imprimé vu en 2D après routage et compilation. 

 

Les pistes en rouge indiquent la face avant et les pistes bleues indiquent  la  face arrière  et les 

composants sont en jaune.  

Et puisque Altium Designer est un logiciel professionnel, il va nous permettre de visualiser le 

circuit en 3D (Figure 46 et 47).  
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Figure 46 - La face avant ou Top Layer  du PCB vue en 3D.   

 

 

Figure 47 - La face arrière ou Bottom Layer du PCB vue en 3D. 
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Ensuite,  nous devons s’assurer que nous n’avons pas commis d’erreurs pendant le routage en 

ouvrant le Design Rule Check (Figure 48). 

 

Figure 48 - DRC du routage réalisé sur Altium Designer. 

 

6.3.3    Génération des fichiers de sortie  

La norme Gerber est une norme internationale utilisée par tous les fabricants de circuits 

imprimés, mais aussi par la majeure partie des machines à graver. Les types des fichiers de 

sortie générés sont les suivants, 

- CAMtastic Top Overlay Gerber Data qui a l’extension .GTO (Figure 49) 

 

Figure 49 - L’image du Top Overlay avec Altium Designer. 
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- CAMtastic Top Layer Gerber Data qui a l’extension .GTL  (Figure 50) 

 

Figure 50 - L’image du Top Layer avec Altium Designer. 

 

- CAMtastic Bottom Layer Gerber Data qui a l’extension .GBL (Figure 51) 

 

Figure 51 - L’image du Bottom Layer avec Altium Designer. 
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- CAMtastic Drill Drawing Layer Pair Gerber Data qui a l’extension .GDD (Figure 52) 

Figure 52 - L’image des trous de perçage avec Altium Designer. 

 

 

 

 

 

 

 

 

 

 

 

 

CONCLUSION ET PERSPECTIVES 
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En conclusion nous avons étudié toutes les étapes dans la réalisation d’une carte électronique 

de sa conception jusqu’à sa fabrication. Pour cela nous avons étudié toute l’étape de 

conception grâce à des logiciels spécialisés permettant de réaliser facilement des schémas 

fonctionnels et électriques puis de gérer le routage du circuit comme Altium Designer 10. 

Ensuite nous avons détaillé les différentes étapes dans la fabrication du circuit imprimé, à 

savoir l’impression du typon, l’insolation, la révélation puis la gravure ainsi que nous avons 

relevé les différentes technologies de composants telle que les composants traditionnels et les 

composant SMD. Ces technologies impliquant chacune des procédures de fabrication très 

différentes, l’une réservée à un usage industriel, l’autre relativement accessible à tout un 

chacun. 

Enfin un exemple d’application pour démontrer la familiarisation avec le logiciel de 

conception en appliquant les étapes de la saisie du schématique passant par le routage jusqu’à 

la génération des fichiers de sortie Gerber. 

Comme perspectives de ce travail, il reste à tester, à vérifier et à valider le circuit imprimé, 

ensuite de l’envoyer à une usine pour fabrication.   
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